
About Global-OPT 

Welcome to Global-OPT. Global-OPT is a Microsoft Excel COM Add-it that frequently finds the global optimum for a specified Objective. 
The optimization is performed by utilizing OPTIMUM’s proprietary expert Design of Experiments and optimization technology (U.S. Patent 
7,260,516) while varying the specified DesignSpaceVariables within a defined Design Space. 

The Global-OPT family of products consists of: 

� Global-OPT2: up to 2 variables, 1 objective

� Global-OPT5: up to 5 variables, 1 objective

Installing Global-OPT

Global-OPT is installed by running Setup.exe. Before running setup, please make sure your system meets the minimum hardware and 
software requirements. 

Global-OPT Hardware Requirements

� CPU: 500 MHz processor or faster

� RAM: 256MB or more

� Hard Disk Space: 100 MB free space required for install

� Monitor: 800 X 600 or higher

� Internet connectivity is required for installing on Microsoft Windows XP if the .NET Framework 3.5 and .NET 
Framework 4.0 are not already installed

Global-OPT Software Requirements

� Operating System: Microsoft Windows XP with Service Pack 2, Vista, or Windows 7

� Microsoft Office: 2003, 2007, or 2010

� Additional Software included and automatically installed by setup if necessary:

Microsoft Windows Installer 3.1 

Microsoft Windows Imaging Components (installed as a component of the Microsoft .NET Framework 3.5 if necessary) 

Microsoft .NET Framework 4.0 

Microsoft Office and Excel Primary Interop Assemblies 

Update KB908002 for .NET Framework and Office 

Global-OPT Serial

Global-OPT5 options and expiration date are controlled by a Serial. A Serial is a string of upper case letters and numbers similar to the 
following: 

ABCDEFGH-01234567-IJKLMNOP-98765432 

If no Serial has been entered, then Global-OPT2 will start up. A Serial may be entered via the About Tab of the Global-OPT dialog. 

Global-OPT Setup

After Setup starts, it verifies that each required software component is installed, if a required software component is not installed, Setup 
automatically installs it. This process could take from several seconds to 20 minutes or more depending on which software components 
need to be installed and the speed of your computer. While verifying and installing required software components, Setup displays a 
dialog similar to the following: 
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After all required software components have been verified, Setup displays the following dialog: 

Click the "Yes" radio button and click the "Next" button to continue. Setup will invoke the Microsoft Windows Installer to complete the 
installation. The Microsoft Windows Install launches the Global-OPT Setup Wizard. The Global-OPT Setup Wizard will display the 
following opening dialog: 
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Click the "Next" button to continue. The Global-OPT Setup Wizard will display the following dialog: 

Click the "Yes" radio button to indicate that you have read, understood and agree to the terms of the license agreement. Note that the 
license agreement also appears in files License.doc and License.rtf in the same directory as Setup.exe, in case you would like to print it. 
Click the "Next" button to continue. The Global-OPT Setup Wizard will display the following dialog: 
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The default install folder for Global-OPT is C:\Program Files\OPTIMUM Power Technology\GlobalOPT. If you wish to install to another 
folder, click the "Change" button and specify that folder. Note that Global-OPT must be installed to a local hard drive; it may not be 
installed to a mapped drive or a network drive. If you install for "Just me", the default, Global-OPT will only be available when your 
Windows user is logged on to this PC. If you install for "Everyone", Global-OPT will be available for any user that logs on to this PC. 
Click the "Next" button to continue. the Global-OPT Setup Wizard will display the following dialog: 

Click the "Next" button to start the installation. As the installation progresses, the Global-OPT Setup Wizard displays the following 
dialog: 
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When the installation is complete, the Global-OPT Setup Wizard displays the following dialog: 

Click the "Finish" button to terminate the Global-OPT Setup Wizard. The Windows Start menu now has the Global-OPT group: 

Running Global-OPT
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Global-OPT is launched from the Excel Tools menu. 

The Global-OPT Dialog has Design, Options and About tabs and a Close button. Help may be requested by clicking the question mark (?) 
located on the right side of the title bar or by pressing F1. 

Close Button 

Close will close the window and save the Global-OPT information in the worksheet so that it can be used again another time. The 
workbook must be saved to retain the Global-OPT information with the worksheet. Only the DoE specifications and the results of the 
most recent Iteration or Refine process are saved; results of intermediate Iterate and Refine processes are not saved.

Design Tab 

The Design tab has a Task Panel, a DesignSpace Panel, an Exploration Power and Investigation Panel, an Optimize button, a Refine 
Button, and a Restore Button. 

Task Panel 

The Task panel is where you specify the Objectives for the optimization. You may also specify additional constraints on the 
Objectives. The Task panel has a tree with Objectives and Constraints nodes and buttons that allow you to Add, Remove, or Change 
a subnodes of the Objectives and Constraints nodes. 

Objectives Node 

Each Objective node that appears under the Objectives node displays the Objective type (Minimize, Maximize or Match), the 
Objective cell, and the Match value for Match type Objectives. 

To add an Objective node, click the Objectivews node if it is not highlighted, then click the Add button. After the Add button is 
clicked, the Objective dialog is displayed. The Objective dialog is described later in this document. 

To remove an Objective node, click the Objective node you wish to remove, then click the Remove button. 

To change an Objective node, click the Objective node you wish to change, then click the Change button. After the Change 
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button is clicked, the Objective dialog is displayed. The Objective dialog is described later in this document. 

Constraints Node 

Each Constraint node that appears under the Constraints node represents an additional criterion that is applied to the Objectives 
during the course of the optimization. A Constraint is a mathematical expression that evaluates to true or false for a given set of 
values. If the expression evaluates to true, the given set of variable values is included in the optimization; if the expression 
evaluates to false, the set of variable values is excluded from the optimization. Each side of the expression may contain cell 
specifications, constants and operators. 

To add a Constraint node, click the Constraints node if it is not highlighted, then click the Add button. After the Add button is 
clicked, the Constraint dialog is displayed. The Constraint dialog is described later in this document. 

To remove a Constraint node, click the Constraint node you wish to remove, then click the Remove button. 

To change a Constraint node, click the Constraint node you wish to change, then click the Change button. After the Change 
button is clicked, the Constraint dialog is displayed. The Constraint dialog is described later in this document. 

DesignSpace Panel 

The DesignSpace panel is where you specify the values that may be varied to achieve the Objective that you specified in the 
Objectives Panel. You may also specify additional constraints on these values. The DesignSpace panel has a tree with Variables 
and Constraints nodes and buttons that allow you to Add, Remove or Change subnodes of the Variables and Constraints nodes. 

Variables Node 

Each Variable node that appears under the Variables node represents a cell that is modified during the optimization. 

To add a Variable node, click the Variables node if it is not highlighted, then click the Add button. After the Add button is clicked, 
the DesignSpaceVariable dialog is displayed. The DesignSpaceVariable dialog is described later in this document. 

To remove a Variable node, click the Variable node you wish to remove, then click the Remove button. 

To change a Variable node, click the Variable node you wish to change, then click the Change button. After the Change button is 
clicked, the DesignSpaceVariable dialog is displayed. The DesignSpaceVariable dialog is described later in this document. 

Constraints Node 

Each Constraint node that appears under the Constraints node represents an additional criterion that is applied to a set of 
variable values that is selected during the course of the optimization. A Constraint is a mathematical expression that evaluates to 
true or false for a given set of variable values. If the expression evaluates to true, the given set of variable values is included in 
the optimization; if the expression evaluates to false, the set of variable values is excluded from the optimization. Each side of the 
expression may contain variable cell specifications, constants and operators. 

To add a Constraint node, click the Constraints node if it is not highlighted, then click the Add button. After the Add button is 
clicked, the Constraint dialog is displayed. The Constraint dialog is described later in this document. 

To remove a Constraint node, click the Constraint node you wish to remove, then click the Remove button. 

To change a Constraint node, click the Constraint node you wish to change, then click the Change button. After the Change 
button is clicked, the Constraint dialog is displayed. The Constraint dialog is described later in this document. 

Exploration Power and Investigation Panel 

The Exploration Power and Investigation panel is where you specify how quickly you want the optimization to run. The Exploration 
Power and Investigation panel has 3 options: Low, Medium and High. 

Low Option 

When selected this will produce the quickest result although it may not be the global optimum. This is suitable for less complex 
problems or where a quick answer is desired. 

Medium Option 

When selected this will take longer by evaluating more points and perform a more comprehensive investigation for global 
optimum. This is suitable for more complex problems or where a better answer, than could be achieved by refining a Low power, 
is desired. 
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High Option 

When selected this will take longer by evaluating more points and a performing very extensive investigation for the global 
optimum. This is suitable for more complex problems or where a better answer, than could be achieved by refining a Medium 
power, is desired. 

Optimize Button 

Clicking Optimize presents the Iterating dialog and initiates a process to produce a quick approximation of the global optimum. Once 
an Objective is iterated, it can be further refined to produce a better answer. The Iterating dialog is described later in this document. 

Refine Button 

Clicking Refine presents the Iterating dialog and initiates a process to produce a better answer up until the answer cannot be refined 
any further. Maximum refinements is 30. The Iterating dialog is described later in this document. 

Restore Button 

After a single Iterate process has completed, Restore restores each DesignSpaceVariable cell to its initial value. After multiple Iterate 
and Refine processes have completed, Restore displays the Restore dialog where you may select whether to restore the previous 
value or the initial value of each DesignSpaceVariable cell. The Restore dialog is described later in this document. 

Global-OPT Options Tab

The Options tab shows a list of checkboxes that correspond to options that you may set. 

The Options tab has the following items. 

Close Iterating form when Iteration Completes Checkbox 

This option corresponds to the Auto-Close Checkbox on the Iterating Dialog. This option is saved and restored across Global-OPT 
starts. 

Automatically Check For Product Updates Checkbox 

When checked, this option causes Global-OPT to periodically check the OPTIMUM Power Technology FTP site for service packs 
and if found, gives you an opportunity to download a service pack. 

Global-OPT About Tab

The Global-OPT About tab is displayed if you click the About tab on the Global-OPT dialog. The About tab displays the current Global-
OPT version, copyright information, and serial information. In addition, it has a Serial button and a Copy button. 
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Serial Button 

Clicking the Serial button displays a New Serial dialog where you may enter a new serial. 

Copy Button 

Clicking the Copy button causes the information displayed on the About tab to be copied to the system clipboard. 

Objective Dialog

The Objective dialog is displayed in response to clicking the Add or Change button on the Task Panel of the Design tab of the Global-
OPT dialog while the Objectives node or an Objective node is highlighted. The Objective dialog has an Objective Cell textbox, an 
Objective selection button, an Objective type dropdown, a Target value textbox, as well as OK, Cancel and Help buttons. 

V (Objective Cell Selection Button) 

After the Objective Cell selection button is clicked, the Objective Selection dialog is displayed. The Objective Selection dialog is 
described later in this document. 

Objective Cell Textbox 

Objective cell specifies the address of a cell that contains an Objective that will be globally optimized based upon the Objective type. 
Use the V button, or enter any single cell here. 

Type 

This is a dropdown list that specifies the criteria for finding the global optimum: Maximize, Minimize or Match. 

Target Value 

A Match Objective type requires a Target Value to define the value that is to be matched. The Target Value can be assigned any real 
value. 
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Objective Selection Dialog 

The Objective Selection dialog is presented in response to clicking the Objective Cell Selection button on the Objective dialog. The 
objective Selection dialog has an Objective Cell box and OK and Cancel buttons. After the Objective Selection dialog is displayed, the 
Excel worksheet is enabled so you may click the cell that contains the Objective Value for your optimization. Clicking a cell causes the 
cell address to be placed in the Select Objective Cell box. In addition, you may drag across several cells or control-click several cells to 
specify multiple Objective cells. 

OK Button 

Clicking OK will dismiss the Objective Selection dialog and place the selected cell address in the Objective Cell box of the Objective 
dialog. 

Cancel Button 

Clicking cancel will dismiss the Objective Selection dialog and not alter the Objective dialog. 

DesignSpaceVariable Dialog

The DesignSpaceVariable dialog is presented in response to clicking the Add or Change button on the DesignSpace panel of the 
Global-OPT dialog while the Variables node or a Variable node is highlighted. The DesignSpaceVariable dialog has a Cell textbox, a 
Cell selection button, a Type dropdown, a Current Value box, Minimum and Maximum value textboxes, Continuous, Round to, and 
Increment by radio buttons, Round to and Increment by textboxes, and OK, Cancel and Help buttons. When presented in response to 
the Add button, the DesignSpaceVariable dialog automatically invokes the DesignSpaceVariable Selection dialog. The 
DesignSpaceVariable Selection dialog is described later in this document. 

V (Cell Selection Button) 

After the Cell selection button is clicked, the DesignSpaceVariable Selection dialog is displayed. The DesignSpaceVariable Selection 
dialog is described later in this document. 

Cell Textbox 

This specifies the address of the cell that contains the selected DesignSpaceVariable. Use the V button, or any single cell can be 
entered here. 

Type Dropdown 

The Type dropdown specifies the value type of the DesignSpaceVariable. Supported types include Real, Integer and Binary. Real is 
any real numeric value. Integer is any integer numeric value. Binary variables have the value of 0 or 1. 

Current Value Box 
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This displays the current value of the selected DesignSpaceVariable cell. 

Minimum Value Textbox 

This is the minimum value for the selected DesignSpaceVariable cell which limits the size of the DesignSpace. 

Maximum Value Textbox 

This is the maximum value for the selected DesignSpaceVariable cell which limits the size of the DesignSpace. 

Continuous Radio Button 

Checking this option means that the DesignSpaceVariable may assume any value from the Minimum to the Maximum value. 

Round to Radio Button and Textbox 

Checking this option means that DesignSpaceVariable values will be rounded to the value specified in the Round to textbox. 

Increment by Radio Button and Textbox 

Checking this option means that DesignSpaceVariables are restricted to the Minimum value plus a multiple of the Increment. For 
example, for a Minimum value of -3 and a Maximum Value of 3 and an Increment of 2, DesignSpaceVariable values of -3, -1, 1, and 
3 will be considered. 

OK Button 

Clicking OK will dismiss the DesignSpaceVariable dialog and place the information it collected into the DesignSpace panel in the 
Global-OPT dialog. 

Cancel Button 

Clicking cancel will dismiss the DesignSpaceVariable dialog and not alter the Global-OPT dialog. 

Help Button 

Help will bring up this information. 

DesignSpaceVariable Selection Dialog

The DesignSpaceVariable Selection dialog is presented in response to clicking the Cell Selection button on the DesignSpaceVariable 
dialog. The DesignSpaceVariable Selection dialog has a Cell box and OK and Cancel buttons. After the DesignSpaceVariable Selection 
dialog is displayed, the Excel worksheet is enabled so you may click the cell that contains a DesignSpaceVariable Value for your 
optimization. Clicking a cell causes the cell address to be placed in the Select DesignSpaceVariable Cell box. 

OK Button 

Clicking OK will dismiss the DesignSpaceVariable Selection dialog and place the selected cell address in the Cell box of the 
DesignSpaceVariable dialog. 

Cancel Button 

Clicking cancel will dismiss the DesignSpaceVariable Selection dialog and not alter the DesignSpace Variable dialog. 

Constraint Dialog

The Constraint dialog is presented in response to clicking the Add or Change button on the DesignSpace panel of the Global-OPT 
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dialog while the Constraints node or a Constraint node is highlighted. The Constraint dialog displays the left and right side of the 
Constraint and has Edit Left Side and Edit Right Side buttons, an Operation dropdown and OK, Cancel and Help buttons. When 
presented in response to the Add button, the Constraint dialog automatically invokes the Constraint Side dialog for the Left Side of the 
Constraint. The Constraint Side dialog is described later in this document. 

Edit Left Side Button 

After the Edit Left Side button is clicked, the Constraint Side dialog is displayed for the Left Side of the Constraint. The Constraint 
Side dialog is described later in this document. 

Operation Dropdown 

Use the Operation Dropdown to specify the comparison operation to perform between the Left Side and Right Side when evaluating 
the Constraint. The Operation dropdown contains symbols for Not Equal, Greater Than, Greater Than Or Equal, Less Than, and 
Less Than Or Equal. 

Edit Right Side Button 

After the Edit Right Side button is clicked, the Constraint Side dialog is displayed for the Right Side of the Constraint. The Constraint 
Side dialog is described later in this document. 

OK Button 

Clicking OK will dismiss the DesignSpaceVariable dialog and place the information it collected into the DesignSpace panel in the 
Global-OPT dialog. 

Cancel Button 

Clicking cancel will dismiss the Constraint dialog and not alter the Global-OPT dialog. 

Help Button 

Help will bring up this information. 

Constraint Side Dialog

The Constraint Side dialog is presented in response to clicking the Edit Left Side or Edit Right Side button of the Constraint dialog. The 
Constraint Side dialog permits you to enter a mathematical expression consisting of constants, variables and operators. The Constraint 
Side dialog has an Expression edit box, a Numeric button group, an Operator button group, an Editting button group, and OK, Cancel 
and Help buttons. 
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Expression Edit Box 

The Expression edit box displays the expression that you are editting for the Left Side or Right Side of a Constraint. You may enter 
information into the expression using the buttons or the keyboard. The edit box contains a vertical bar cursor (|). Any information you 
enter appears to the right of the vertical bar. You may also select information by dragging the mouse over a portion of the edit box. 
Selected information appears highlighted. If text is selected, a keystroke or button click will replace the selected text. 

Numeric Button Group 

The numeric button group contains buttons for the digits 0 to 9, decimal point and PI. Use these buttons to enter a constant. 

Operator Button Group 

The operator button group contains buttons for addition, subtraction, multiplication, division, exponentiation, and parentheses. 

Editing Button Group 

The editing button group contains a Clear button, a Backspace button, a Delete Button and a Variable button. 

Clear Button 

Clicking the Clear button erases all information from the expression edit box. 

Backspace Button 

Clicking the Backspace button (or the Backspace key) erases one character to the left of the cursor. 

Delete Button 

Clicking the Delete button (or the Delete key) erases one character to the right of the cursor. 

Variable Button 

After the Variable selection button is clicked, the Variable Selection dialog is displayed. The Variable Selection dialog is described 
later in this document. 

Variable Selection Dialog

The Variable Selection dialog is presented in response to clicking the Variable button on the Constraint Side dialog. The Variable 
Selection dialog has a Cell box and OK and Cancel buttons. After the Variable Selection dialog is displayed, the Excel worksheet is 
enabled so you may click the cell that contains the Variable that you wish to enter into the constraint. Clicking a cell causes the cell 
address to be placed in the Select DesignSpaceVariable Cell box. 
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OK Button 

Clicking OK will dismiss the Variable Selection dialog and place the selected cell address in the expression box of the Constraint 
Side dialog. 

Cancel Button 

Clicking cancel will dismiss the DesignSpaceVariable Selection dialog and not alter the DesignSpaceVariable dialog. 

Iterating Dialog

After clicking the Iterate or Refine button on the Global-OPT dialog, the Excel window and Global-OPT dialog is hidden and the Iterating 
dialog is presented. The Iterating dialog has a Status Message, a Status box, Auto-Close checkbox, and Cancel and Copy buttons. 

Status Message 

The Status message indicates the current state of the Iterate or Refine process. While busy, it has the text "Iterating". When the 
current process completes, it has the text "Iteration complete". It may also display the text "Iteration cancelled" or "Iteration 
abended". 

Status Box 

The Status box displays progress messages while the current Iterate or Refine process is running with the most recent progress 
message at the top. After the current process completes, the contents of the Status box may be copied to the system clipboard by 
clicking the Copy button. 

Auto-Close Checkbox

The Auto-Close checkbox instructs the Iterating dialog to automatically close when the current Iterate or Refine process ends. After 
the Iterating dialog closes, the Global-OPT dialog and Excel window become visible again. 

Cancel Button 

Clicking the Cancel button prematurely terminates the current Iterate or Refine process. 

Copy Button 

The Copy button is enabled after the current Iterate or Refine process ends. Clicking the Copy button copies the contents of the 
Status box to the system clipboard. 

Restore Dialog

The Restore dialog is presented in response the clicking the Restore button on the Global-OPT dialog if more than one Iterate or Refine 
process has run. The Restore dialog has an Initial Values option button, a Previous Values option button, and OK, Cancel and Help 
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buttons. 

Initial Values Option 

If you select the Initial Values option and click the OK button, Global-OPT restores the initial values of the DesignSpaceVariable 
cells. These are the values of the DesignSpaceVariable cells at the time Global-OPT was started. 

Previous Values Option 

If you select the Previous Values option and click the OK button, Global-OPT restores the previous values of the 
DesignSpaceVariable cells. These are the values of the DesignSpaceVariable cells before the most recent Iterate or Refine process. 

OK Button 

Clicking the OK button dismisses the Restore dialog and restores the DesignSpaceVariable cells base on the selected option. 

Cancel Button 

Clicking the Cancel button dismisses the Restore dialog and does not alter the DesignSpaceVariable cells. 

Help Button 

Help will bring up this information. 

Serial Dialog

The Serial dialog permits you to enter a new serial. The Serial dialog is presented in response to pressing the Serial button on the About 
tab of the Global-OPT dialog. The Serial dialog consists of a Current serial textbox, a New serial textbox, and OK, Cancel, and Help 
buttons. 

Current Serial Textbox 

This textbox displays the current serial that is in effect. This textbox may not be changed. 

New Serial Textbox 

Enter or paste your new serial into this textbox. 

OK Button 

Clicking the OK button dismisses the Serial dialog and validates and installs the new serial. 

Cancel Button 

Clicking the Cancel button dismisses the Serial dialog and does not alter the current serial. 

Help Button 

Help will bring up this information. 

Page 15 of 17Global-OPT Help

4/12/2012file:///M:/DOES/SRC/GlobalOPTHelp/en/GlobalOPT.htm



3 Up 3 Down Sample

This is a modified version of a function called “Peaks” from MATLAB, whose function is: 

f(x,y) = 3*(1-x)CurrentSerial2 * Exp(-(xCurrentSerial2) - (y+1)CurrentSerial2) - 10*(x/5-xCurrentSerial3-yCurrentSerial5) * Exp(-
xCurrentSerial2-yCurrentSerial2) - 1/3 * Exp(-(x+1)CurrentSerial2-yCurrentSerial2) 

This function will result in values from approximately -6.55 to +8.08. 

To run the Example: 

Open EXCEL and load the 3up3down.xls spread sheet. Be sure that the chart is not the currently selected cell. If the chart is selected 
then click on any cell on the sheet. 

Click “Tools” then "Global-OPT" from the Excel menu bar. 

Make sure the Objectives node is highlighted in the Task panel and click the Add button in the Task panel. The Objective Selection dialog will 
be shown on top of the Objective dialog and the Excel sheet will be enabled. 

Click the spreadsheet cell B6 as the Objective. 

Click the “OK” button. 

Make sure the Variables node is highlighted in the DesignSpace panel and click the Add button in the DesignSpace panel. The 
DesignSpaceVariable Selection dialog will be shown on top of the DesignSpaceVariable dialog and the Excel sheet will be enabled. 

Click on the spreadsheet cell B4 as the first DesignSpaceVariable. 

Click on the “OK” button. (this closes the DesignSpaceVariable Selection dialog) 

Enter a Minimum value of -3. 

Enter a Maximum of 3. 

Your DesignSpaceVariable window should look the same as the window below: 
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Click on the “OK” button. 

Click on the “Add” button. (this opens the DesignSpaceVariable Selection dialog) 

Click on the spreadsheet cell B5 as the second DesignSpaceVariable and click on the "OK" button to return to the DesignSpaceVariable 
dialog. 

Enter a Minimum value of -3. 

Enter a Maximum of 3. 

Click on the “OK” button. (this closes the DesignSpaceVariable window) 

Click on the “OK” button. 

Your Global-OPT window should look the same as the window below: 

Click on the “Iterate” button. 

After reviewing the information in the “Iterating” window Click the “Close” button. 

X = -0.4219, Y = 1.3594, and Z = 8.1050 

To get better answers click on the “Refine” button; or select the “Medium” or “High” options and then click on the “Iterate” button. 
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